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Getting Started

Congratulations on your purchase of the Chart Pattern Systems 3.0 (CPS3) plug-in. 
Chart patterns help you interpret price formations and their implications for the future 
of a security. Identifying successful chart patterns is key to highly effective trading. 
The Chart Pattern Systems 3.0 plug-in is a comprehensive collection of Nirvana’s 
chart pattern technology.

Chart Pattern Systems Concept
The Chart Pattern Systems technology is based on the databases designed for the 
Chart Pattern Recognition Module (CPRM). CPRM uses a process that identifies the 
most predictive chart patterns. Performance statistics are then recorded in a database 
for each chart pattern in order to identify the most profitable patterns. The Chart 
Pattern Systems plug-in takes these advanced technologies one step further and uses 
a collection of trading systems and strategies to give you signals on patterns so that 
you can find opportunities quickly. With Chart Pattern Systems, you will see buy and 
sell signals on the vote line and in the Focus List. 

Installing the Chart Pattern Systems 3.0 Plug-in
Before you can begin using the Chart Pattern Systems 3.0 plug-in, confirm that you 
have OmniTrader 2009 installed. Then, follow these instructions to install the CPS3 
plug-in:
1. Insert the Chart Pattern Systems 3 CD into the CD-ROM drive. The installation 

should begin automatically. If it does not, click Start»Run from the Windows 
Start menu. 
Type x:\setup.exe (where x is the CD-ROM drive you are using) in the command 
line box and click OK.

2. Follow the instructions that appear in the installation wizard dialog boxes.
s 3.0 User Guide
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Registering Chart Pattern Systems 3.0
Before you can use the CPS3 plug-in, you must register the software. In order to 
register, you will need your customer number and your CD-Key, which are supplied 
on the email that you received when you purchased the product.
1. Double-click on the OmniTrader icon on your desktop to launch the program or 

select Start»Programs»OmniTrader 200X»OmniTrader 200X.
2. If the Product Registration dialog box does not appear, select Help»Registration.

Figure 1-1.  Product Registration Dialog Box

3. Enter your Nirvana ID and Password. This information can be located on the 
back of your OmniTrader Professional CD case.

4. Click Get My CD Keys to register OmniTrader and all of the plug-ins you own.

Activating Trading Strategies
The Chart Pattern Systems plug-in contains many end of day stock/futures strategies. 
These strategies use pattern signals to find decisive breakouts, reversals, and swing 
trades.  For more information about each of the strategies, refer to Chapter 2, CPS3 
Strategies.
© Nirvana Systems Inc. 2 Chart Pattern Systems 3.0 User Guide
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You can access the CPS3 Trading Strategies from the To Do List in OmniTrader. 
1. Select View»To Do List.
2. Click on the Strategies tab, and you will see a list of the strategies installed on 

your system. 

Figure 1-2.  Strategies Tab in the To Do List

3. Activate the strategy you would like to use by placing a checkbox in the Enable 
column. The strategies that are selected to run in the current profile are indicated 
with a check mark to the left of the strategy name. If you want to edit a strategy, 
highlight it and click on the Edit button or simply double-click on it.
Chart Pattern Systems 3.0 User Guide 3 nirvanasystems.com
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Using the Strategy Menu
The Strategy menu provides you with quick access to the analysis and signals 
generated for each of your trading strategies, as well as immediate access to the 
strategy’s flow chart. The Strategy menu is located at the top of your OmniTrader 
screen.

Figure 1-3.  Strategy Menu

When you select a strategy from the drop-down menu, your Focus List and Vote Line 
will reflect the results of the selected Strategy(s). You can access the flow chart for 
any strategy by selecting it from the drop-down menu and then clicking on the 
Strategy (chess piece) icon next to the strategy name.

Plotting Chart Pattern Systems
You can plot the Chart Pattern Systems on your charts by enabling them on the 
Systems tab of the Chart Options dialog box. 
1. Select View»Chart Options.
2. Click on the Systems tab to see a list of the systems installed on your computer.

Note The system(s) you select will remain plotted until you deselect it or 
click the All Off button.
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Figure 1-4.  Systems Tab on the Chart Options Dialog Box

3. Activate the system you would like to apply by placing a checkbox in the Enable 
column. The systems that are selected to run in the current profile are indicated 
with a check mark to the left of their name.

Note You can also add a system to your chart by right-clicking on the chart 
and selecting Add System from the menu.
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Modifying System Settings
Each system has specific parameters that are related to the indicator on which the 
system is based. However, they all share parameters that are related to the 
identification of trendlines. Once you have added a system to a chart, you can change 
the parameters and line styles of the system by double-clicking on the system in your 
chart or by clicking on the Edit button in the Chart Options dialog box. If you want to 
change the default parameter values, you can type in the desired indicator values or 
use the scroll bars to adjust the settings.

Figure 1-5.  Saucer Pattern System Display Settings

Note The system parameters refer to the settings of the plotted system only. 
The system parameters do not affect a strategy’s signal generation.
© Nirvana Systems Inc. 6 Chart Pattern Systems 3.0 User Guide
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You can also access parameter settings in a strategy’s Systems and Confirmation 
Blocks. As shown below, the parameters are presented differently in the Block dialog 
box. The Systems and Confirmation Blocks dictate the parameters used by the system 
in order to generate signals within a Trading Strategy.

Figure 1-6.  CPS3 Consolidation Pattern Parameters in the Systems Block
Chart Pattern Systems 3.0 User Guide 7 nirvanasystems.com
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CPS3 Strategies

The Chart Pattern Systems 3 plug-in provides you with nine Trading Strategies that 
you can use to find trading candidates. While you can edit all of these strategies, 
Nirvana Systems recommends that you save any changes made to the supplied 
strategies under a different name. This will keep the initial settings of these strategies 
intact for future use or reference. 

The CPS3 plug-in strategies are fully Mechanical. Each strategy, with the exception 
of CPS3 Swing and CPS3 Position Trading, measures the moving average on the 
S&P500 index confirming market direction to allow a signal through.

Tip The S&P500 index (symbol $SPX) must have data for signals to pass 
through to the voteline.

The CPS Plug-in includes the following prospecting strategies:
• CPS3 Consolidation Strategy
• CPS3 Fibonacci Retracement Strategy
• CPS3 Gap Strategy
• CPS3 Position Trading Strategy
• CPS3 Saucer Strategy
• CPS3 Support & Resistance Strategy
• CPS3 Swing Strategy
• CPS3 Trendline Strategy
• CPS3 Volume Strategy
s 3.0 User Guide
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CPS3 Consolidation Strategy
The CPS3 Consolidation Strategy identifies breakout (or continuation) signals after a 
consolidation forms. 

The CPS3 Consolidation Strategy uses OmniTraders Voting Process on the 7 most 
profitable consolidation pattern systems for its initial signal generation and then 
confirms the signal with a market trend filter on the S&P500 index. It also contains a 
filter for closing price to be above $10 and uses the CPS3 MultiStep Trade Plan for 
exiting.

The signals from this strategy tend to identify longer term consolidation patterns as 
opposed to some of the tight, shorter term patterns.

.

Figure 2-1.  CPS3 Consolidation Strategy Signal on Chart for MRK

Strategy Characteristics
• Type of Trade—Trend Continuation
• Term of Trade—Medium-term
Chart Pattern Systems 3.0 User Guide 9 nirvanasystems.com
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CPS3 Fibonacci Retracement Strategy

Fibonacci Retracements are a phenomena where charts typically reverse after giving 
up or advancing 32%, 50%, or 62% of a prior move. 

The CPS3 Fibonacci Retracements Strategy uses OmniTraders Voting Process on the 
PAT3-FIB (Fibonacci) system for its initial signal generation and then confirms the 
signal with a market trend filter on the S&P500 index. It also contains a filter for 
closing price to be above $10 and uses the CPS3 MultiStep Trade Plan for exiting.

This strategy is designed to find short-term turns at retracement levels and to 
capitalize on them quickly.

Figure 2-2.  CPS3 Fibonacci Retracement Strategy Signal on Chart for PCP

Strategy Characteristics
• Type of Trade—Trend Reversal
• Term of Trade—Short-term
© Nirvana Systems Inc. 10 Chart Pattern Systems 3.0 User Guide
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CPS3 Gap Strategy
Gaps are sudden price movements that leave a gap or hold between the prior days 
closing price and the current days opening price. 

The CPS3 Gaps Strategy uses the Voting Process on the four gap systems for its initial 
signal generation and then confirms the signal with a market trend filter on the 
S&P500 index. It also contains a filter for close price above $10 and uses the CPS3 
MultiStep Trade Plan for exiting. The four gap systems attempt to identify the four 
most common types of gaps: Breakaway, Exhaustion, Common, and Measured gaps. 
It uses an advanced algorithm that looks at chart behavior leading into the gap in order 
to define the gap type. By identifying the different types of gaps, this strategy will 
generate reversal as well as continuation signals.

Figure 2-3.  CPS3 Gap Strategy Signal Example

Strategy Characteristics:
• Type of Trade —Trend Continuation and Trend Reversal
• Term of Trade—- Short to Medium-term
Chart Pattern Systems 3.0 User Guide 11 nirvanasystems.com



Chapter 2  CPS3 Strategies
CPS3 Position Trading Strategy

The CPS Position Trading Strategy uses the CPS Head and Shoulders, Double 
Bottoms/Tops and Triple Bottoms/Tops systems to find good position trading 
candidates. Since these occurrences are rare, there is no filtering or confirmation used 
on the strategy. While signals are not as common in this strategy as others, the quality 
of these signals is outstanding considering that there is no confirmation used. This 
strategy will only generate long signals. It exits after a loss of 3 ATRs or after a move 
of 1 ATR in the direction of the trade it activates a 0.5 ATR Trailing Profit Stop.

Figure 2-4.  CPS3 Position Trader Strategy Signal on Chart for ABT

Strategy Characteristics:
• Type of Trade—Extended position trading opportunities
• Term of Trade— Medium to Long-term
© Nirvana Systems Inc. 12 Chart Pattern Systems 3.0 User Guide
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CPS3 Saucer Strategy
Saucers are the rarest of the seven major chart patterns, but they are also one of the 
most predictive patterns. 

The CPS3 Saucers Strategy uses OmniTraders Voting Process on the PAT3-SAU 
(Saucer) system for its initial signal generation and then confirms the signal with a 
market trend filter on the S&P500 index. It also contains a filter for closing price to 
be above $5 and uses the CPS3 Trade Plan for exiting.

Figure 2-5.  CPS3 Saucer Strategy Signal on VAR

Strategy Characteristics
• Type of Trade—Trend Reversal
• Term of Trade—Medium-term
Chart Pattern Systems 3.0 User Guide 13 nirvanasystems.com
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CPS3 Support & Resistance Strategy
Support and Resistance are classic chart levels where buyers and sellers halt the 
advance or decline of a stock. 

The CPS3 SupportResistance Strategy looks for both reversal and continuation 
opportunities when it detects a support/resistance break or a support/resistance 
bounce. It uses OmniTraders Voting Process on the PAT3-SR (SupportResistance) 
system for its initial signal generation and then confirms the signal with a market 
trend filter on the S&P500 index. It uses the CPS3 MultiStep Trade Plan for exiting.

Figure 2-6.  CPS3 Support & Resistance Strategy Signals on Chart for Sprint

Strategy Characteristics
• Type of Trade—Trend Reversal and Trend Continuation
• Term of Trade—Medium-term
© Nirvana Systems Inc. 14 Chart Pattern Systems 3.0 User Guide



Chapter 2  CPS3 Strategies
CPS3 Swing

The CPS3 Swing Strategy is designed to find short term moves on momentum. It uses 
14 of the Chart Pattern Systems and looks for agreement from at least two of the 
systems before passing a signal to the Vote Line. Due to the volatility breakout 
confirmation system this strategy fires signals during times when volatility surges. It 
also applies an RSI filter that will pass signals when the 14 period Relative Strength 
is within the range of 30 and 70. This strategy will exit a trade after a gain of 1 ATR 
or loss of 2 ATRs.

Figure 2-7.  CPS3 Swing Strategy Signal on Chart for SJM

Strategy Characteristics:
• Type of Trade—Short-term swing moves
• Term of Trade—Short-term
Chart Pattern Systems 3.0 User Guide 15 nirvanasystems.com
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CPS3 Trendlines

Similar to Support and Resistance, when price goes through a trendline, the market 
often reacts by buying or selling in the direction of the break or bounce. 

The CPS3 Trendlines Strategy looks for both reversal and continuation opportunities 
when it detects a trendline break or a trendline bounce. It uses OmniTraders Voting 
Process on the PAT3-TLN (Trendline) system for its initial signal generation and then 
confirms the signal with a market trend filter on the S&P500 index. It uses the CPS3 
Trade Plan for exiting.

Figure 2-8.  CPS3Trendline Strategy Signal on Chart for CTX

Strategy Characteristics:
• Type of Trade—Trend Continuation and Trend Reversal
• Term of Trade—Medium-term
© Nirvana Systems Inc. 16 Chart Pattern Systems 3.0 User Guide
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CPS3 Volume Strategy

CPS3 Volume looks for key volume patterns, such as volume climaxes and volume 
trend, to identify reversals and key break out moves.

The CPS3 Volume Strategy uses OmniTraders Voting Process on the PAT3-VOL 
(Volume) system for its initial signal generation and then confirms the signal with a 
market trend filter on the S&P500 index. It also contains a filter for closing price to 
be above $5 and uses the CPS3 MultiStep Trade Plan for exiting. 

Figure 2-9.  CPS3 Volume Strategy Signals on Chart for TSS

Strategy Characteristics
• Type of Trade—Trend Reversal and Trend Continuation
• Term of Trade—Medium-term
Chart Pattern Systems 3.0 User Guide 17 nirvanasystems.com
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CPS3 Trade Plans

Trade Plans use a step-by-step process to manage a trade. There are two Trade Plans 
provided with the CPS3 module that determine when to exit trades: The CPS3 Trade 
Plan and the CPS3 Multi-Step Trade Plan.

CPS3 Trade Plan
Two of the CPS3 Strategies use the specially created CPS3 Trade Plan block for exits 
in place of the Orders block. This Trade Plan uses a Fixed Loss Stop (3 ATRs) as a 
protective stop and a Trailing Profit Stop (Threshold = 3 ATRs, Cushion = 3 ATRs) 
as a profit stop. It will also activate a Break Even Stop (0.5 ATRs) once price exceeds 
2 ATRs to the gain side.

Figure 3-1.  CPS3 Trade Plan View

The Strategies that use this Trade Plan include:
• CPS3 Trendlines 
• CPS3 Saucers.
s 3.0 User Guide
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CPS3 Multi-Step Trade Plan

Five of the CPS3 Strategies use the specially created CPS3 Multi-Step Trade Plan 
block for exits in place of the Orders block. The CPS3 Multi-Step Trade Plan is a 
four-step trade plan created to capture as much of the move as possible. Step two of 
the Trade Plan applies a tight Trailing Profit Stop to lock in profits in the case of a 
pull-back. A move of two ATR’s to the gain side of the position triggers the Fixed 
Profit Stop to manage the position through step three where the Trade Plan is 
configured to wait one bar before applying the final step.

Figure 3-2.  CPS3 Multi-Step Trade Plan View

The Strategies that use this Trade Plan include:
• CPS3 Consolidations
• CPS3 Fibonacci Retracements
• CPS3 Gaps
• CPS3 SupportResistance
• CPS3 Volume
Chart Pattern Systems 3.0 User Guide 19 nirvanasystems.com
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Chart Pattern Systems

The Chart Pattern Systems plug-in includes systems for identifying the 7 key chart 
patterns, long-term patterns, and candle patterns.

After you install the CPS3 plug-in, the systems included appear in the System and 
Confirm Blocks of your strategies. As with all other systems, you can use the Chart 
Pattern Systems to generate signals, to confirm signals in other strategies, and even 
to generate exits. 

The CPS3 trading systems use improved algorithms and are more configurable than 
the systems used in earlier versions of Chart Pattern Systems. 

These new and improved Chart Pattern Systems are included in CPS3:
• CPS3 Consolidation Pattern System
• CPS3 Fibonacci Retracement System
• CPS3 Gap Pattern System
• CPS3 Saucer Pattern
• CPS3 Support and Resistance Pattern System
• CPS3 Trendline Pattern System
• CPS3 Volume Pattern System

The following systems use the original Chart Pattern System Technology:
• Consolidation System (PAT-CNS)
• Fibonacci Retracement System (PAT-FIB)
• Gap System (PAT-GAP)
• Saucer System (PAT-SAU)
• Support and Resistance System (PAT-SR)
• Trendline System (PAT-TLN)
• Volume System (PAT-VOL)
s 3.0 User Guide
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Consolidation Systems
A consolidation occurs when buyers and sellers are very closely matched in numbers, 
causing the security’s price to move within a well-defined trading range. The point 
where the price moves outside the trading range that forms the consolidation is called 
a breakout. A breakout can be to the upside or to the downside. 

Figure 4-1.  Consolidation Pattern Example

CPS3 Parameters
The CPS3 Consolidation System uses the following parameters:
• Type of Pattern

– 0 — All consolidations
– 1 — Rectangle
– 2 — Rectangle Top
– 3 — Rectangle Bottom
– 4 — Triangle, Ascending
– 5 — Triangle, Descending
– 6 — Triangle, Symmetrical
– 7 — Wedge, Rising
– 8 — Wedge, Falling
– 9 — Wedge, Rising Continuation
Chart Pattern Systems 3.0 User Guide 21 nirvanasystems.com
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– 10 — Wedge, Falling Continuation
– 11 — Broadening Top
– 12 — Broadening Bottom
– 13 — Broadening Continuation
– 14 — Broadening Reversal
– 15 — Flag, Rising
– 16 — Flag, Falling
– 17 — Flag, Rising Reversal
– 18 — Flag, Falling Reversal
– 19 — Flag, Rising Continuation
– 20 — Flag, Falling Continuation

• Max Width—Maximum consolidation price width in ATR's 
• Min Length—Minimum pattern length in bars 
• Max Length—Maximum pattern length in bars 
• Anchor Distance— Minimum distance from anchor in ATR's
• Strength—Defines the strength setting of the patterns displayed. A strength of 1 

is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern. Each pattern is subdivided into groups, 
so that strength varies within each pattern. For example, consolidations are 
divided into the various types of consolidations, such as Ascending Triangles, 
Rectangles, and Pennants.
© Nirvana Systems Inc. 22 Chart Pattern Systems 3.0 User Guide
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CPS Parameters
The Consolidation System uses the following parameters:
• Term of Pivots Used—Defines the term of pivot points to use in generating a 

pattern and signals. A pivot point is defined as a place on the chart where the 
security changed trend direction. The application attempts to find pivot points that 
reinforce the short, medium, and long-terms used in OmniTrader. By defining the 
term of pivot points we want the system to use, we can better define the type of 
signals generated. A short-term pattern occurs from 1-16 bars. A medium-term 
pattern falls between 17-32 bars, and a long-term pattern occurs at 33 bars or 
greater.
There are several different options you can use to define the Pivots Term:
– Short-term
– Medium-term
– Short and Medium-term
– Long-term
– Short and Long-term
– Medium and Long-term
– All

• Display Target Projection—Displays the target projection for the consolidation. 
The time frame of the consolidation is used to determine the target. For example, 
if the consolidation lasts four weeks, you would expect to see the previous 
significant low or high four weeks before the beginning of the consolidation. 
Then, you would expect to see the target price projection four weeks from the end 
of the consolidation.

• Min Pivots on Trendline—Defines the number of pivot points the plug-in must 
find in order to identify a trendline. The default setting is 2.

• Min Leadin Height—Defines the minimum distance allowed from the anchor to 
the first pivot point in the consolidation. This parameter is figured as a percentage 
of the first pivot’s price. The minimum leadin height can be a negative value. 

• Max Leadin Height—Defines the maximum distance allowed from the anchor 
to the first pivot point in the consolidation. This parameter is figured as a 
percentage of the first pivot’s price.
Chart Pattern Systems 3.0 User Guide 23 nirvanasystems.com
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• Min Left Cons Height—Defines the minimum height allowed on the left side of 
the consolidation. This parameter is figured as a percentage of price measured 
from the first pivot point.

• Max Left Cons Height—Defines the maximum height allowed on the left side 
of the consolidation. This parameter is figured as a percentage of price measured 
from the first pivot point.

• Min Right Cons Height—Defines the minimum height allowed on the right side 
of the consolidation. This parameter is figured as a percentage of price measured 
from the first pivot point.

• Max Right Cons Height—Defines the maximum height allowed on the right side 
of the consolidation. This parameter is figured as a percentage of price measured 
from the first pivot point.

• Min Cons Width—Defines the minimum allowable distance in bars from the 
breakout to the first pivot point.

• Max Cons Width—Defines the maximum allowable distance in bars from the 
breakout to the first pivot point.

• Max Center Line Slope—Defines the maximum allowable center line slope. 
This parameter calculates the normalized slope.

• Min Aspect Ratio—Defines the minimum allowable height to width ratio 
measured along the center line. This parameter is figured as a percentage based 
on the first pivot point divided by the number of bars.

• Max Aspect Ratio—Defines the maximum allowable height to width ratio 
measured along the center line. This parameter is figured as a percentage based 
on the first pivot point divided by the number of bars.

• Max Pattern Length—Defines the maximum allowable distance in bars from the 
anchor to the breakout.

• Strength—Defines the strength setting of the patterns displayed. A strength of 1 
is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern. Each pattern is subdivided into groups, 
so that strength varies within each pattern. For example, consolidations are 
divided into the various types of consolidations, such as Ascending Triangles, 
Rectangles, and Pennants. 
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Fibonacci Retracement Systems
Leonardo Fibonacci discovered a sequence of numbers where each successive 
number is the sum of the two previous numbers. Ratios of the Fibonacci numbers to 
each other form the retracement values 38% (3/8), 50% (4/8), and 62% (5/8). We use 
these retracement values to predict reversal points or changes in price trends, also 
known as retracements. A retracement is a reversal in the prevailing trend for a 
security. Often, securities retrace some percentage of a move after making a long 
move in a given direction. 

As a Fibonacci Retracement forms, you will see the price retreating from a high to a 
percentage of the prior move. For example, if you look at a security’s most recent 
significant low and high and measure between these two points, you can look for a 
retracement at 38%, 50%, or 62% from the last pivot point. 

Figure 4-2.  Fibonacci Retracement Pattern Example

CPS3 Parameters
The CPS3 Fibonacci Retracement System uses the following parameters:
• Type of Pattern:

– 0 — All Fibonacci Retracement Patterns
– 1 — 38% Retracement
– 2 — 50% Retracement
– 3 — 62% Retracement
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• Min Length—Minimum pattern length in bars
• Max Length— Maximum pattern length in bars Short-Term 
• Short-Term Max Width—Maximum width of short-term retracement in ATR's 
• Medium-Term Max Width—Maximum width of medium-term retracement in 

ATR's 
• Long-Term Max Width—Maximum width of long-term retracement in ATR's
• Strength—Defines the strength setting of the patterns displayed. A strength of 1 

is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern. 

CPS Parameters
The Fibonacci Retracement System uses the following parameters:
• Confirmation Bars—Defines the maximum number of bars OmniTrader will 

wait to confirm movement after a retracement is identified.
• Minimum Bars in Trend—Defines the minimum number of bars in the trend 

leading up to the retracement.
• Ratio—Specifies that the system identify 38%, 50%, 62%, or All retracement 

levels in the chart.
• Min Length—Defines the minimum allowable distance in bars from the first 

Fibonacci level to the break.
• Max Length—Defines the maximum allowable distance in bars from the first 

Fibonacci level to the break.
• Strength—Defines the strength setting of the patterns displayed. A strength of 1 

is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern. 
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Gap Systems
A gap occurs when the high of the day is below the low of the previous day or when 
the low of the day is above the high of the previous day. A gap is often seen at points 
of high or low demand for the security. Gaps are powerful tools for predicting future 
behavior of a security. Usually, the buying or selling pressure that created the gap will 
result in a significant move.

The Chart Pattern Systems plug-in recognizes breakaway, measured, exhaustion, and 
common gaps.

Figure 4-3.  Gap Pattern Example

CPS3 Gap Parameters
The CPS3 Gap System uses the following parameters:
• Type of Pattern

– 0 — All Gap Patterns
– 1 — Breakaway Gap
– 2 — Measured Gap
– 3 — Exhaustion Gap
– 4 — Common Gap
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• Gap Size Factor—Minimum ratio of gap over average recorded gap 
• Gap MA Period— Period used to calculate average gap 
• Min Relative Gap Size—Minimum gap size (percent) 
• Max Relative Gap Size—Maximum gap size (percent)
• Strength—CPRM3 strength rating

CPS Parameters
The Gap System uses the following parameters:
• Gap Size Factor—Specifies that in order to be identified, a gap must be greater 

than this factor. This parameter is figured by multiplying the factor with a moving 
average of all the gaps leading up to the current gap.

• Gap MA Period—Defines the period to use in the moving average that 
determines the Gap Size Factor parameter.

• Type—Specifies that the system identify Breakaway, Measured, Exhaustion, 
Common, or All gaps in the chart.

• Min Relative Gap Size—Defines the minimum allowable absolute gap value 
divided by the stock’s price.

• Max Relative Gap Size—Defines the maximum allowable absolute gap value 
divided by the stock’s price.

• Strength—Defines the strength setting of the patterns displayed. A strength of 1 
is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern.
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Saucer Systems
A saucer is a reversal chart pattern and represents a long consolidation period that 
turns from a bearish bias to a bullish bias. Saucers are often long patterns, and for this 
reason, they are easier to identify in a weekly chart. While they are fairly uncommon, 
they are often very predictive. 

As a saucer pattern forms, you will see a clear arc with tight trading ranges at the 
bottom of the arc. The price trend shows a gradual change in trend as it develops, 
curving gently over several months, usually. You will often see a similar trend in 
volume.

Figure 4-4.  Saucer Pattern Example

CPS3 Saucer Parameters
The CPS3 Saucer System uses the following parameters:
• Max Width—Maximum width in ATR's
• Min Length—Minimum pattern length in bars 
• Max Length—Maximum pattern length in bars 
• Anchor Distance—Minimum distance from anchor in ATR's
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• Strength—Defines the strength setting of the patterns displayed. A strength of 1 
is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern.

CPS Parameters
The Saucer System uses the following parameters:
• Dropoff—Specifies the allowable dropoff value. This parameter is a ratio figured 

by dividing the distance of the previous long-term pivot point by the saucer 
height.

• Min Length—Defines the minimum allowable distance in bars from the first bar 
in the saucer to the last bar, which is the pattern break.

• Max Length—Defines the maximum allowable distance in bars from the first bar 
in the saucer to the last bar, which is the pattern break.

• Strength—Defines the strength setting of the patterns displayed. A strength of 1 
is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern.
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Support & Resistance Systems
Support is a level on the chart (or in the market) where there is enough demand for 
the security to overcome selling pressure. This causes the downward trend to halt and 
turn up again. Support levels indicate that most investors feel the security is oversold.

Resistance is the opposite of support—it represents a level on the chart (or in the 
market) where there is enough supply of a security to overcome buying pressure. This 
causes the upward trend to halt and turn down. Resistance levels indicate that most 
investors feel the security is overbought.

Figure 4-5.  Support & Resistance Pattern Example

CPS3 and CPS Parameters
The Support and Resistance Systems for all version of CPS uses the following 
parameters:
• Term of Pivots—Defines the term of pivot points to use in generating a pattern 

and signals. A pivot point is defined as a place on the price bar where the security 
changed price direction. The application attempts to find pivot points that 
reinforce the short, medium, and long-terms used in OmniTrader. By defining the 
term of pivot points we want the system to use, we can better define the type of 
signals generated. A short-term pattern occurs from 1-16 bars. A medium-term 
pattern falls between 17-32 bars, and a long-term pattern occurs at 33 bars or 
greater.
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There are seven different options you can use when defining the Pivots Term:
– Short-term
– Medium-term
– Short and Medium-term
– Long-term
– Short and Long-term
– Medium and Long-term
– All

• Break Type—Specifies whether to identify breaks, reversals, or both on the 
chart. A break is indicated by a break in the line. A break is helpful in identifying 
an area in the chart where the trend is likely to continue. A reversal is indicated 
by a sudden change in the price direction of a security.

• Correlation Coefficient—Defines the correlation coefficient of the 
Support/Resistance pattern. This parameter is figured as an R-squared based 
calculation of the correlation between the pivot points that form the support and 
resistance pattern.

• Min Length—Defines the minimum allowable distance in bars from the first 
pivot point to the last pivot point.

• Max Length——Defines the maximum allowable distance in bars from the first 
pivot point to the last pivot point.

• High/Low over N Periods—Defines the number of bars before the first pivot 
point in which the chart cannot break the support or resistance level. This 
parameter is figured based on high and low prices.

• Allow One Pivot Breaks—Specifies that the plug-in will find trendline breaks 
that have only one pivot point.

• Draw ATR Band—Draws an Average True Range band on the pattern. Average 
True Range measures the volatility of the security. 

• Strength—Defines the strength setting of the patterns displayed. A strength of 1 
is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern. 
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Trendline System
A trendline is a straight line drawn on a chart of a security to depict the general 
direction the security is headed. A trendline forms across the peaks and valleys (pivot 
points) in a chart. As the line becomes validated with more pivot points, its 
significance increases. A break in a well-established trendline usually signals a trend 
reversal. 

Figure 4-6.  Trendline Pattern Example

CPS3 and CPS Parameters
The Trendline System for all versions of CPS uses the following parameters:
• Pivots Term—Defines the term of pivot points to use in generating a pattern and 

signals. A pivot point is defined as a place on the chart where the security changed 
trend direction. The application attempts to find pivot points that reinforce the 
short, medium, and long-terms used in OmniTrader. By defining the term of pivot 
points we want the system to use, we can better define the type of signals 
generated. A short-term pattern occurs from 1-16 bars. A medium-term pattern 
falls between 17-32 bars, and a long-term pattern occurs at 33 bars or greater. 
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There are seven different options you can use when defining the Pivots Term:
– Short-term
– Medium-term
– Short and Medium-term
– Long-term
– Short and Long-term
– Medium and Long-term
– All

• Break Type—Specifies whether to identify breaks, reversals, or both on the 
chart.

• Min. Pivots on Trendline—Defines the number of pivot points the plug-in must 
find in order to identify a trendline. The default setting is 2.

• Min Length—Defines the minimum allowable distance in bars from the first 
pivot point to the last pivot point.

• Max Length—Defines the maximum allowable distance in bars from the first 
pivot point to the last pivot point.

• Min Distance btw Points—Defines the minimum allowable distance between 
pivot points. Pivot Points are identified by touches to the line.

• Max Distance btw Points—Defines the maximum allowable distance between 
pivot points. Pivot Points are identified by touches to the line.

• Min Slope—Defines the minimum allowable slope. Slope is an increase in the 
price per bar. This parameter is annualized to fit all timeframes.

• Max Slope—Defines the maximum allowable slope. Slope is an increase in the 
price per bar. This parameter is annualized to fit all timeframes.

• Display Bands—Draws an Average True Range band on the pattern. Average 
True Range measures the volatility of the security 

• Strength—Defines the strength setting of the patterns displayed. A strength of 1 
is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern. 
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Volume System
Volume measures the number of traded shares or contracts for a security over a period 
of time. Volume is simply the number of shares that are bought/sold. For example, if 
you buy 200 shares of a security from a seller, the volume for that period of time 
would increase by 200 because of your transaction.

A Volume Climax pattern is a place where volume increases and then decreases. The 
difference between a Volume Climax and a Volume Trend is that in a Volume Climax 
pattern, when you have volume turning around, the price chart also turns around. It 
can either turn to the downside or to the upside. On a Volume Trend pattern, you have 
the price continuing to move in the same direction that it was moving before. Volume 
Trend almost works like a Measured Gap to measure the midpoints of moves in 
charts.

Figure 4-7.  Volume Pattern Example

CPS3 Parameters
The CPS3 Volume System uses the following parameters:
• Type of Pattern:

– 0 — All Volume Patterns
– 1 — Volume Climax
– 2 — Volume Trend
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• Volume MA Period—Period used to calculate average volume 
• Min Volume Spike Factor—Minimum ratio of volume over average recorded 

volume 
• Max Volume Spike Factor—Maximum ratio of volume over average recorded 

volume
• Strength—Defines the strength setting of the patterns displayed. A strength of 1 

is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern.

CPS Parameters
The Volume System uses the following parameters:
• Volume MA Period—Defines the period to use in the moving average that 

determines the Volume Spike Factor parameter.
• Type—Specifies that the system identify Climax, Trend, or All volume systems 

in the chart.
• Min Volume Spike Factor—Specifies that in order to be identified, volume must 

be greater than this factor. This parameter is figured by multiplying the factor with 
a moving average of all the volume leading up to the current volume spike.

• Max Volume Spike Factor—Specifies that in order to be identified, volume 
must be less than this factor. This parameter is figured by multiplying the factor 
with a moving average of all the volume leading up to the current volume spike.

• Strength—Defines the strength setting of the patterns displayed. A strength of 1 
is the weakest, displaying all patterns detected by the module. A strength of 5 is 
the strongest, displaying only the most historically profitable patterns. The 
strength rating comes from an analysis of over one million bars of market data and 
is based on the profitability of the pattern.
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Long Term Pattern Systems

The long term pattern systems included with the CPS plug-in are designed to fire 
signals on patterns that indicate long term moves, lasting weeks or even months. The 
long term pattern systems are designed to detect major shifts in investor psychology. 

The Chart Pattern Systems plug-in contains the following long-term pattern systems:
• Double Bottoms and Double Tops System (PAT-DBM)
• Head and Shoulders and Inverted Head and Shoulders System (PAT-HNS)
• Triple Bottoms and Triple Tops System (PAT-TBM)

Double Bottoms & Double Tops System
The double bottom chart pattern occurs in the market when the price of a security 
drops, rebounds, drops again to the same or similar level as the initial drop, and 
rebounds again. The two drops form a support level for the security. The double 
bottom pattern looks like the letter “W” on a chart. 

The double top chart pattern occurs in the market when the price of a security rises, 
drops, rises again to the same or similar level as the initial rise, and finally drops 
again. The two rises form a resistance level for the security. The double top pattern 
looks like the letter “M” on a chart. 
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Figure 5-1.  Double Bottoms & Double Tops Pattern Example

The Double Bottoms and Double Tops System generates a signal when a double top 
or double bottom formation occurs.

Parameters
The Double Bottoms and Double Tops System use the following parameters:
• Pivots Term—Defines the term of pivot points to use in generating a pattern and 

signals. A pivot point is defined as a place on the chart where the security changed 
trend direction. The application attempts to find pivot points that reinforce the 
short, medium, and long-terms used in OmniTrader. By defining the term of pivot 
points we want the system to use, we can better define the type of signals 
generated. A short-term pattern occurs from 1-16 bars. A medium-term pattern 
falls between 17-32 bars, and a long-term pattern occurs at 33 bars or greater. 
There are seven different options you can use when defining the Pivots Term:
– Short-term
– Medium-term
– Short and Medium-term
– Long-term
– Short and Long-term
– Medium and Long-term
– All
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• Shape Sensitivity—Defines how close to the same level the tops and bottoms 
must be before a signal is generated.

• Center Symmetry—Defines how close to perfectly center the central valley or 
peak must be before a signal is generated. A setting of 0 is a perfectly centered 
peak or valley.

• Anchor—Specifies the minimum size of the pattern origin relative to the peak of 
the pattern. In order to be considered for signal generation, this level must be 
exceeded. For example, if you set the anchor value at 1.5, the CPS plug-in will 
only recognize patterns that have an anchor point of at least one and a half times 
the pattern peak.

• Pivot Width—Specifies the minimum number of bars between the pivots a 
pattern must be before a signal is generated.

• ATR Periods—Defines the number of periods used in Average True Range 
(ATR) calculations. ATR measures the volatility of the security

• Peak Cross—Specifies whether the signal is fired when the pivot formation 
occurs or when the center peak or valley level is crossed. Select 0 to set the signal 
to fire when the pivot is formed. Select 1 to set the signal to fire when the center 
peak or valley level is crossed.
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Head and Shoulders & Inverted Head  
and Shoulders System
The head and shoulders chart pattern occurs in the market when the price of a security 
rises to a peak, drops, rises above the previous peak, drops again, rises again but not 
to the same level as the initial rise, and finally declines once more. The first and last 
peak make the shoulders of the pattern, and the middle (and highest) peak makes the 
head of the pattern.

The inverted head and shoulders pattern occurs in the market when the price of a 
security drops to a peak, rises, drops below the previous peak, rises again, drops again 
but not to the same level as the initial drop, and finally rises once more. 

The Head and Shoulders and Inverted Head and Shoulders System generates a signal 
when a classic head and shoulders or inverted head and shoulders formation occurs.

Figure 5-2.  Head and Shoulders & Inverted Head and Shoulders Pattern Example
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Parameters
The Head and Shoulders and Inverted Head and Shoulders System use the following 
parameters:
• Pivots Term—Defines the term of pivot points to use in generating a pattern and 

signals. A pivot point is defined as a place on the chart where the security changed 
trend direction. The application attempts to find pivot points that reinforce the 
short, medium, and long-terms used in OmniTrader. By defining the term of pivot 
points we want the system to use, we can better define the type of signals 
generated. A short-term pattern occurs from 1-16 bars. A medium-term pattern 
falls between 17-32 bars, and a long-term pattern occurs at 33 bars or greater. 
There are seven different options you can use when defining the Pivots Term:
– Short-term
– Medium-term
– Short and Medium-term
– Long-term
– Short and Long-term
– Medium and Long-term
– All

• Shape Sensitivity—Defines how close to the same level the tops and bottoms 
must be before a signal is generated.

• Max Slope—Specifies the maximum absolute value of the slope of the trendline 
drawn through the shoulders.

• Anchor—Specifies the minimum size of the pattern origin relative to the head of 
the pattern. In order to be considered for signal generation, this level must be 
exceeded. For example, if you set the anchor value at 1.5, the CPS plug-in will 
only recognize patterns that have an anchor point of at least one and a half times 
the pattern head.

• Pivot Width—Specifies the minimum number of bars between the pivots a 
pattern must be before a signal is generated.

• ATR Periods—Defines the number of periods used in Average True Range 
(ATR) calculations. ATR measures the volatility of the security
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• Trendline—Specifies whether the signal is fired when the pivot formation occurs 
or when the trendline formed by the shoulders is crossed. Select 0 to set the signal 
to fire when the pivot is formed. Select 1 to set the signal to fire when the trendline 
is crossed.

Triple Bottoms & Triple Tops System
The triple bottom chart pattern occurs in the market when the price of a security 
drops, rebounds, drops again to the same or similar level as the initial drop, rebounds 
again, drops again, and finally rebounds for a third time. The three drops form a 
support level for the security. 

The triple top chart pattern occurs in the market when the price of a security rises, 
drops, rises again to the same or similar level as the initial rise, drops, rises again, and 
finally drops for a third time. The three rises form a resistance level for the security.

The Triple Bottoms and Triple Tops System generates a signal when a triple top or 
triple bottom formation occurs.

Figure 5-3.  Triple Bottom & Triple Tops Pattern Example
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Parameters
The Triple Bottom System uses the following parameters:
• Pivots Term—Defines the term of pivot points to use in generating a pattern and 

signals. A pivot point is defined as a place on the chart where the security changed 
trend direction. The application attempts to find pivot points that reinforce the 
short, medium, and long-terms used in OmniTrader. By defining the term of pivot 
points we want the system to use, we can better define the type of signals 
generated. A short-term pattern occurs from 1-16 bars. A medium-term pattern 
falls between 17-32 bars, and a long-term pattern occurs at 33 bars or greater. 
There are seven different options you can use when defining the Pivots Term:
– Short-term
– Medium-term
– Short and Medium-term
– Long-term
– Short and Long-term
– Medium and Long-term
– All

• Shape Sensitivity—Defines how close to the same level the tops and bottoms 
must be before a signal is generated.

• Center Symmetry—Defines how close to perfectly center the central valley or 
peak must be before a signal is generated. A setting of 0 is a perfectly centered 
peak or valley.

• Anchor—Specifies the minimum size of the pattern origin relative to the peak of 
the pattern. In order to be considered for signal generation, this level must be 
exceeded. For example, if you set the anchor value at 1.5, the CPS plug-in will 
only recognize patterns that have an anchor point of at least one and a half times 
the pattern peak.

• Pivot Width—Specifies the minimum number of bars between the pivots a 
pattern must be before a signal is generated.
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• ATR Periods—Defines the number of periods used in Average True Range 
(ATR) calculations. ATR measures the volatility of the security

• Peak Cross—Specifies whether the signal is fired when the pivot formation 
occurs or when the center peak or valley level is crossed. Select 0 to set the signal 
to fire when the pivot is formed. Select 1 to set the signal to fire when the center 
peak or valley level is crossed.
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Candle Pattern Systems

Candle Patterns are used in technical analysis to identify short-term imbalances 
between buyers and sellers. Candle Patterns are especially useful for confirming other 
patterns.

The Candle Pattern Systems included with the CPS plug-in are improved versions of 
the Candle Pattern Systems included in the base version of OmniTrader. The systems 
in this plug-in use adjusted ratio calculations. The original Candle Pattern Systems 
also use Point and Figure analysis to characterize trends that lead up to the patterns in 
order to better recognize continuation and/or reversals. The CPS3 Candle Pattern 
systems no longer use Point and Figure and have slightly different parameter 
configurations.

CSP3 Candle Pattern System Parameters:
• Type of Pattern:

– 0 — All Candles
– 1 — Hammer
– 2 — Hanging Man
– 3 — Belt Hold
– 4 — Piercing Lines
– 5 — Dark Cloud Cover
– 6 — Engulfing Lines
– 7 — Harami
– 8 — Inverted Hammer
– 9 — Shooting Star
– 10 — Counterattack
– 11 — Kicking
– 12 — Doji Star
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– 13 — Morning Star
– 14 — Evening Star
– 15 — Three Inside Up
– 16 — Three Inside Down
– 17 — Three Outside Up
– 18 — Three Outside Down
– 19 — Three White Soldiers
– 20 — Three Black Crows
– 21 — Stick Sandwich
– 22 — Side By Side White Lines
– 23 — Tasuki
– 24 — Three Methods

All of the Candle Pattern Systems in this plug-in include a pattern strength setting that 
you can modify. When you add a system to your chart, the Settings dialog box for that 
system will appear, allowing you to change the strength setting. You can also 
double-click on a system in the chart to display this dialog box.

Figure 6-1.  All Pattern Strengths Activated

The strength rating comes from an analysis of over one million bars of market data 
and is based on the profitability of the pattern. You should experiment with the 
strength rating buttons to determine the strength that best suits your particular trading 
style. Using a setting of 1 displays all patterns detected by the module, while a setting 
of 5 displays only the most historically profitable patterns. 
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The Chart Pattern Systems plug-in contains the following Candle Pattern Systems:
• CPS: Belt Hold Candle Pattern System (PAT-CN-BH)
• CPS: Counterattack Candle Pattern System (PAT-CN-CA)
• CPS: Doji Star Candle Pattern System (PAT-CN-DS)
• CPS: Engulfing Lines Candle Pattern System (PAT-CN-EL)
• CPS: Harami Candle Pattern System (PAT-CN-HAM)
• CPS: Hammer/Hanging Man Candle Pattern System (PAT-CN-HMR)
• CPS: Inverted Hammer/Shooting Star Candle Pattern System (PAT-CN-IHM)
• CPS: Kicking Candle Pattern System (PAT-CN-KCK)
• CPS: Morning/Evening Stars Candle Pattern System (PAT-CN-MES)
• CPS: Piercing/Dark Could Cover Candle Pattern System (PAT-CN-PL)
• CPS: Stick Sandwich/Side by Side White Lines Candle Pattern System 

(PAT-CN-SSS)
• CPS: Tasuki Candle Pattern System (PAT-CN-TAS)
• CPS: Three Inside Candle Pattern System (PAT-CN-TI)
• CPS: Three Methods Candle Pattern System (PAT-CN-TM)
• CPS: Three Outside Candle Pattern System (PAT-CN-TO)
• CPS: Three White Soldiers/Black Crows Candle Pattern System (PAT-CN-TSC)
Chart Pattern Systems 3.0 User Guide 47 nirvanasystems.com



Chapter 6  Candle Pattern Systems
Belt Hold Candle Pattern System
The Belt Hold candle pattern is formed by a range which extends in the direction of 
the close. 

Figure 6-2.  Belt Hold Candle Pattern Example

In terms of market psychology, the Belt Hold indicates a strong move in a given 
direction, with slight hesitation at the end of the day. In most markets, Belt Holds 
occur frequently and are considered of minor significance in forecasting reversals. 
They usually indicate a continuation of the current trend. (Nison 1991, p. 94) 

A Bearish Belt Hold exists when the high equals the open and the low is below the 
close. A Bullish Belt Hold Line is formed when the low equals the open and the high 
is above the close. 

The PAT-CN-BH System trades long when a Bullish Belt Hold is discovered in the 
data and short when a Bearish Belt Hold is encountered. 

Belt Holds occur frequently. Price will usually move in the direction of the close 
following a Belt Hold line. 
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Counterattack Candle Pattern System
The Counter Attack Line candle pattern is a two-day pattern in which today’s close is 
approximately the same as the prior day’s close, but today’s direction is opposite.

Figure 6-3.  Counterattack Candle Pattern Example

Counter Attacks occur when the market reverses direction violently to arrive at the 
same value as the prior period. Counter Attack Lines are reversal patterns, and are of 
moderate significance at the end of intermediate trends. 

The Counter Attack Line occurs infrequently, and usually forecasts a reversal. 

Bearish Counter Attack Lines form when the market opens higher but closes lower, 
with the close being equal to the close of the previous period. Bullish Counter Attack 
Lines occur when the market opens lower, but closes higher, with the close being 
equal to the close of the previous period. 

This system trades long when a Bullish Counter Attack is seen, and short when a 
Bearish Counter Attack is seen. 
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Doji Star Candle Pattern System
The Doji Star candle pattern occurs when the closing price is equal to the open price. 
This type of pattern represents indecision in the market and can be a precursor to a 
reversal at the end of an intermediate uptrend or downtrend. 

Figure 6-4.  Doji Star Candle Pattern Example

In some markets, Doji Stars can appear almost every day. In such cases, their value as 
a predictor is questionable. 

The Doji Star System can warn us of reversals. However, some markets typically 
trade in a narrow range and generate many Doji Patterns, thus lessening their 
significance.

The Doji Pattern appears on candle charts as a candle with no body, since the open 
and close are at the same value. 

The Doji Star System trades long when the close occurs at a relative low, indicating 
that the intermediate-term trend is down. It trades short at relative highs. 
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Chapter 6  Candle Pattern Systems
Engulfing Lines Candle Pattern System
Engulfing Lines are one of the most important and powerful candle patterns. To form 
the pattern, today’s range encloses or “engulfs” the prior day’s range, thereby 
indicating great market strength in the direction of today’s close. 

Figure 6-5.  Engulfing Lines Candle Pattern Example

From a psychological perspective, Engulfing Lines indicate that the market opened in 
the same direction as the prior day, but then reversed sentiment to close strongly in 
the opposite direction, overcoming and reversing yesterday’s assumption regarding 
value. 

Bullish Engulfing Line will form if three conditions are satisfied. First, previous day’s 
open must be higher than yesterday’s close (a solid candle). Second, the current day’s 
open must be lower than the previous day’s close. Third, the current day’s close must 
be higher than the previous day’s open. The Bearish Line is just the opposite, where 
a black body encloses a previous white body. 

PAT-CN-EL trades long when a Bullish Engulfing Line forms. Conversely, a short 
trade is entered when a Bearish Engulfing Line is seen. 

Engulfing Lines often forecast major moves when they occur opposite the current 
intermediate or long-term trend. 
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Chapter 6  Candle Pattern Systems
Harami Candle Pattern System
Harami means “pregnant” in Japanese. A Harami is just the opposite of an Engulfing
Line. That is, yesterday’s body engulfs today’s, with opposite color for the two.

Figure 6-6.  Harami Candle Pattern Example

The Harami represents indecision in the market. While typically not as powerful a 
reversal predictor as the Engulfing Line, this pattern can be a good forecaster of 
reversals at the end of intermediate and long-term trends.

A Harami is formed when today’s open and close are entirely within the prior days 
open-to-close range, but opposite in direction. That is, a Bearish pattern occurs when 
a small black body follows a large white body; a Bullish pattern occurs when a small 
white body follows a large black body.

The system trades long when a Bullish Harami is formed and short when a Bearish 
Harami is formed. PAT-CN-HAM trades independent of the current trend.
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Chapter 6  Candle Pattern Systems
Hammer/Hanging Man Candle Pattern System
The Hammer Pattern is formed by a short body at the top of a long tail. Hammers must 
occur at the end of significant trends to have meaning. 

Figure 6-7.  Hammer Candle Pattern Example

Hammers indicate indecision in the direction of the trend. A black (solid) hammer 
which occurs at the end of an uptrend is called a Hanging Man. This type of Hammer 
indicates the market’s propensity to sell off sharply. However, one should wait for the 
next session to confirm the bearish mood (market opening below the close of the 
hammer).

On the other hand, white (open) Hammers which occur at the end of downtrends show 
strength for a reversal to the upside, since the bulls are clearly challenging the 
downtrend to close near the open for the session.

A Hammer occurs when the high, open, and close occur at roughly the same price, 
but the low of the day is far below. 

This system trades long when a Hammer occurs at the end of a downtrend. Trend 
filtering using a moving average is used to verify that an intermediate downtrend has 
been established before the trade will be accepted.

Hammers are of moderate significance, often indicating a trend reversal.
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Chapter 6  Candle Pattern Systems
Inverted Hammer/Shooting Star Candle Pattern System
Inverted Hammers are just the opposite of Hammers, i.e., a small body occurs at the 
bottom of a long tail. Black Inverted Hammers occurring at the end of uptrends are 
clearly bearish, since the market fails in its attempt to rally higher, closing near the 
open. 

Figure 6-8.  Inverted Hammer Candle Pattern Example

However, white Inverted Hammers at the end of downtrends are more subtle, and it 
is important to establish the following day as bullish. It is likely that a short-covering 
rally will ensue, confirming the reversal.

An Inverted Hammer is formed when the open, close, and low occur at approximately 
the same price, with a high extended significantly above the three. The farther away 
the high is for the day, the more significant the pattern in terms of forecasting a 
reversal.

This system trades long when an Inverted Hammer pattern is detected. Inverted 
hammers can be significantly bullish, especially if they have long tails floating up.
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Chapter 6  Candle Pattern Systems
Kicking Candle Pattern System
Kicking patterns are characterized by an evident gap and are strong signs of enhanced 
momentum in market movement. The previous market direction is not as important 
with this pattern as with most other candle patterns.

Figure 6-9.  Kicking Candle Pattern Example

In the bullish kicking pattern, the first bar is characterized by a long black body, while 
the second bar opens above the first bar’s open and has a long white body. In the 
bearish kicking pattern, the first bar is characterized by a long white body, while the 
second bar opens below the first bar’s open and has a long black body. In both cases, 
the shadows of both bars are small relative to their body size.

This system trades long after a bullish Kicking pattern and short after a bearish 
Kicking pattern.
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Chapter 6  Candle Pattern Systems
Morning/Evening Stars Candle Pattern System
A Morning Star is a bullish pattern, and is formed when a small body is located 
between two other bodies so that it appears below (or above) the other two.

Figure 6-10.  Morning/Evening Stars Candle Pattern Example

The star itself can be any color. An Evening Star generates a sell signal when a small 
body is located above two surrounding candles (a bearish indicator).

Morning and Evening Stars are rare, and of moderate significance. Here we can see 
them calling several key reversals in the market. 

The Morning Star pattern is equivalent to a bullish island reversal in Western 
terminology. A black (down) day is followed by a small body which is below the 
range of the solid candle. Then, the (third) day opens up above the range of the second 
day and continues up to form an open candle. That is, the middle day forms an 
“island” of price activity below the other two days. This three-day pattern shows that 
the market has reversed direction. The Evening Star is just the opposite, with the 
middle day forming an island above the two surrounding days.
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Chapter 6  Candle Pattern Systems
Piercing/Dark Could Cover Candle Pattern System
The Piercing Line pattern, as the name implies, occurs when today’s candle “pierces”
the range of the prior day, in the opposite direction.

Figure 6-11.  Piercing Candle Pattern Example

The market opens in the same direction as the previous day, then violently reverses 
direction to close within the range of the previous day. In the bullish case, the bulls 
have clearly driven prices back into the territory of the prior down day, indicating 
strength in the direction of today’s close.

The Bullish Piercing Line is formed when today’s open is below yesterday’s close but 
today’s close is less than yesterday’s high. The Bearish case, also called a Dark Cloud 
Cover, is just the opposite with today’s close greater than yesterday’s open.

The Piercing Line pattern is of major significance, often indicating a powerful 
reversal is about to take place.
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Chapter 6  Candle Pattern Systems
Stick Sandwich/Side by Side White Lines 
Candle Pattern System
The Stick Sandwich is a bullish reversal pattern that entails three consecutive days of 
higher opens, indicating that the market is finding a new support price. The Side by 
Side White Lines is a bearish continuation pattern. In a downtrend, two white bars are 
gapped below a first black bar, meaning that the shorts are covering their positions.

Figure 6-12.  Stick Sandwich Candle Pattern Example

In the bullish Stick Sandwich pattern, the first bar is black, the second bar is white and 
trades above the first bar, and the third bar is black and closes near the close of the 
first bar. In the bearish Side by Side White Lines pattern, the first bar is black, the 
second bar is white and gaps downwards, and the third bar is white and of about the 
same length and close as the previous bar.

This system trades long after a Stick Sandwich pattern and short after a Side by Side 
White Lines pattern.
© Nirvana Systems Inc. 58 Chart Pattern Systems 3.0 User Guide



Chapter 6  Candle Pattern Systems
Tasuki Candle Pattern System
The Tasuki Gaps are continuation patterns. Upside Tasuki Gaps occur in an uptrend: 
a gap is observed after the first bar, followed by a black bar caused by temporary 
profit taking. The uptrend is expected to continue. Similarly, a Downside Tasuki Gap 
is the result of investors taking advantage of the low buying price and should confirm 
an ongoing downtrend.

Figure 6-13.  Tasuki Candle Pattern Example

n the Upside Tasuki Gap, two white bars with an opening gap are followed by a third 
black bar that opens within the body of the second bar and closes within the gap. In 
the Downside Tasuki Gap, two black bars with an opening gap are followed by a third 
white bar that opens within the body of the second bar and closes within the gap.

This system trades long after an Upside Tasuki Gap and short after a Downside Tasuki 
Gap.
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Chapter 6  Candle Pattern Systems
Three Inside Candle Pattern System
This pattern is an extension of the Harami pattern. A third bar is awaited for and used 
as confirmation of the actual reversal.

Figure 6-14.  Three Inside Candle Pattern Example

In the Three Inside Up pattern, a third white bar with a higher close than the previous 
bar follows a bullish Harami pattern. In the Three Inside Down pattern, a third black 
bar with a lower close than the previous bar follows a bearish Harami pattern.

This system trades long after a Three Inside Up pattern and short after a Three Inside 
Down pattern.
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Chapter 6  Candle Pattern Systems
Three Methods Candle Pattern System
The Three Methods is a five-bar continuation pattern. The pattern’s three middle bars 
identify a small temporary reversal in trend, revealing that investors are taking a 
break, while the last bar indicates that the initial trend is expected to resume.

Figure 6-15.  Three Methods Candle Pattern Example

In the bullish version of this candle pattern (also known as the Rising Three Methods), 
a first long white bar is followed by three small bars that identify a downtrend that 
rests within the first bar’s range. Finally a long white bar closes above the close of the 
first bar. Similarly, the bearish Falling Three Methods consists of a first long black 
bar, three small bars in an uptrend that falls within the first bar’s range, and a long 
black bar that closes below the first bar’s close.

This system trades long after a Rising Three Methods pattern and short after a Falling 
three Methods pattern.
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Chapter 6  Candle Pattern Systems
Three Outside Candle Pattern System
This pattern is an extension of the Engulfing Lines pattern. A third bar is awaited
for and used as confirmation of the actual reversal.

Figure 6-16.  Three Outside Candle Pattern Example

In the Three Outside Up pattern, a third white bar with a higher close than the 
previous bar follows a bullish Engulfing Lines pattern. In the Three Outside Down 
pattern, a third black bar with a lower close than the previous bar follows a bearish 
Engulfing Lines pattern.

This system trades long after a Three Outside Up pattern and short after a Three 
Outside Down pattern.
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Chapter 6  Candle Pattern Systems
Three White Soldiers/Black Crows 
Candle Pattern System
This is a reversal pattern identified by three consecutive bars with close prices
that suggest future market strength.

Figure 6-17.  Three White Soldiers Candle Pattern Example

In the bullish Three White Crows, three long white bars occur, each one opening 
within the body of the previous bar and closing above the previous bar and near the 
same bar’s high. In the bearish Three Black Crows, three black bars occur, each one 
opening within the body of the previous bar and closing below the previous bar and 
near the same bar’s low.

This system trades long after a Three White Soldiers pattern and short after a Three 
Black Crows pattern.
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Additional Resources

If you would like to learn more about indicator trendline analysis you may wish to 
review the following resources:
• Profiting with Chart Patterns—Profiting with Chart Patterns is designed to help 

you develop successful trading techniques using chart pattern analysis. The 
Profiting with Chart Patterns seminar provides step by step instructions on how to 
analyze and identify patterns that produce dramatic profits trade after trade. 

• Profiting with Indicators—Profiting with Indicators is designed to show you 
how to improve your trading decisions by using indicators to confirm winning 
trade candidates. Indicators help you visualize important factors such as trend 
direction, price momentum, volatility, and market participation in the form of 
volume. Financial institutions, brokerages, professional traders, and even 
long-term investors make use of indicators when making decisions. 

• Indicator and Systems Help File—The Indicator and Systems Help File 
contains all a description of all of the base OmniTrader indicators and systems as 
well as a description of all of the components of the various plug-ins available. 

• Nirvana Systems Technical Support Team—Our support team is available to 
help you with questions about the various features of the plug-in. You can contact 
them by email at support@nirvsys.com or by phone at 512.345.2592.

Nirvana Systems thanks you for your patronage, and we wish you the best of luck in 
all of your trading endeavors.
stems 3.0 User Guide
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